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Terms of Use

Shareware notice:

This piece of software is distributed as Shareware.
This means that you may try the unregistered version of the program a few times, a maximum of 30 
days, after which it will disable itself. If you decide that you want to continue using it, you must 
register it and pay a fee to obtain a user license. The license is valid for one single user only and 
cannot be transferred or resold. The license will cover all versions of the software, past present and 
future, and so is a once per lifetime expense. The enclosed registration form REGISTER.TXT contains
the details on how to register.

Legalities:

The program and it's components are copyrighted by the author, F. Markus Jönsson, a.k.a. FMJ-
Software.
The program and it's components may not be modified or altered in anyway whatsoever without prior 
consent from the author.
The LZW algorithm used in GIF and TIFF files has been 'Licensed under U.S. Patent No. 4,558,302 
and foreign counterparts' from Unisys.
The Graphics Interchange Format(c) is the Copyright property of CompuServe Inc.
GIF(sm.) is a Service Mark property of CompuServe Inc.
JPEG(sm.) is a Service Mark of the Joint Photographics Experts Group.
The FIF format is the Copyright property of Iterated Systems Inc. and the technology behind it is 
covered by several patents owned by Iterated Systems Inc. This product can make use of their free 
decoder library if it is also installed.
This software is based, in part, on the work of the Independent JPEG Group.
Pentium is a trademark of Intel Corporation.
Windows 3.1, Windows 95, and Windows NT are trademarks of Microsoft Corporation.
All trademarks, servicemarks and other registered names, mentioned in this, and accompanying texts 
are the property of their respective owners.

Distribution:

This product may never be bundled, sold or otherwise distributed with, or as a companion to, a 
commercial product expect by prior consent from the author. Unauthorized reproduction or 
distribution of this program, or any portion of it, may result in sever civil and criminal penalties.
Relaxations: You (an individual or an entity) are hereby authorized to freely keep, distribute and 
multiply copies of the unregistered distribution archive for this software with, through and on, BBB's, 
Internet-sites and equivalent information and on-line services. You are also allowed to store it on 
personal media like hard disks, floppy disks and networks, for personal use, or for sharing with 
friends. You are further allowed to include it on so called 'Shareware collection' CD-ROMs and 
equivalents. Note that these relaxations do not affect the actual use of the software whatsoever. All 
users of such products still have to pay the registration fee to gain the legal right to use this software as
defined in the Shareware statement.



The following files must always supplied:
FILE_ID.DIZ Short program description.
IMAGEEYE.EXE The actual viewer program executable.
IMAGEEYE.HLP Program Manual in WinHelp hypertext format.
IMAGEEYE.JPG A small test file.
REGISTER.TXT Registration form.
README.TXT Installation instructions.

Disclaimer of warranty:

FMJ-Software exclude any and all implied warranties, including warranties of merchantability and 
fitness for a particular purpose.
Nor does FMJ-Software make any warranty of representation, either express or implied, with respect 
to this product, its quality, performance, functionality or fitness for a particular purpose.
Nor shall FMJ-Software have any liability for special, incidental, or consequential damages arising out
of or resulting from any use of this product. 
Nor shall FMJ-Software have any responsibilities, nor any obligations whatsoever to provide support 
for this product.



Getting Started

Welcome to Image Eye!

These are the design goals for Image Eye:
- The only image viewer you should need for browsing images.
- Very fast; See if you can find any faster image viewer!
- Optimized display in all video modes - no compromises in image quality.
- No frills user interface - No scroll bars or window menus taking up precious space.
- Supports most common image file formats.
- Full screen display when the window is maximized.
- Adapts to 'on-the-fly' video mode changes (use with Microsoft's 'QuickRes' utility).
- Index feature with fast image thumbnail creation (no need to cache them on disk).
- Does not attempt to be any half-baked semi-editor or file format converter.
- Takes up very little space (if you put it on a floppy you still have plenty of space left on it for images!).
- Includes a simple slide show scripting language - roll your own presentations!

For installation instructions, read the README.TXT file that comes with the program.
In this section you will be given basic instructions on the rather minimalistic user interface.

Start the program by running ImageEye.Exe.
An 'Open image file' dialog comes up. Here you select the image file you want to view and click View.
If everything goes well, the image now turns up in a window on the screen. A special feature of Image 
Eye is that this window is completely free from scroll bars, tool bars, or any window menu that otherwise 
would occupy precious space and clutter up your desktop.
If the image is larger than the window, the mouse cursor changes shape when you move it over the 
window, indicating in which direction(s) it can be scrolled. To scroll, you press down the left button and 
drag with the mouse. As an alternative you can scroll with the keyboards arrow keys. Insert, Home, 
Delete, End scrolls to the corners of the image.
If you double-click with the left button on the image it is maximized (or restored if already maximized). 
In maximized mode, it will occupy the whole screen; no (disturbing) title bar!
Now you may ask, where is the program menu? Click with the right mouse button on the image and it 
will pop-up!
The complete menu choices are described in the Viewer Commands section.
Apart from those things, the usual Windows conventions for handling windows apply.

There are seven ways that you can open an image file:
1) Run ImageEye.Exe, select one ore more files in the dialog box that pops up and click View.
2) By clicking on an image button in an 'index' window. An index window contains buttons with so called
thumbnail icons (small images) for all image files in a directory. You can bring up an index window by 
either clicking the 'Index' button in the 'open image file' box, or (if you have allowed Image Eye to 
associate file types with itself) by right clicking on a directory in any Windows shell program (like the 
Explorer) and selecting 'Image Eye index'.
3) If Image Eye has been associated with a file type; just double click on one or more files in Windows 
Explorer.
4) In a running Image Eye window, select Spawn new from the right mouse button menu. See 1).
5) In a running Image Eye window, select File->Load new from the right mouse button menu. See 1). 
This will replace the current image.



6) Drag an image file from the Windows Explorer to a running Image Eye window.
7) In an open image window; press PgUp or PgDn to display the previous/next image in the current 
directory.

I hope you will enjoy using Image Eye!



Viewer Commands

Pressing the right mouse button over the image viewer window brings up a menu with the following 
commands:

Spawn new... Opens a new image file in a new window.
Load new... Opens a new image in the current window.
File -> Save as... To save the image in .BMP format (can be read by most 
programs).

Delete file... Lets you delete the current image file from the disk.
Copy to clipboard Puts the image on the clipboard so that you can paste it into other 

apps.
Print image... Lets you make a paper copy.

View -> Next image file Display the (alphabetically) next image file in the current 
directory.

Previous image file Display the (alphabetically) previous image file in the current 
directory.Size window to image Adjust the windows size to the image size.

Size image to window Adjust (resample) the image size to the window size.
Restore originals size Restores the image to the size it had when you first opened it.
Use as desktop wallpaper Sets the image as desktop wallpaper (background image).

Properties Opens a dialog with image information and program settings.
For help, press [?] and then click on the control you want help 

with.
Help Opens this help text.

There is also the following keyboard commands:

Arrow keys Scroll in the arrows direction.
Insert Scroll to upper left corner.
Home Scroll to upper right corner
Delete Scroll to lower left corner
End Scroll to lower right corner
PgUp Display the previous image file in the current directory.
PgDn Display the next image file in the current directory.
Esc Close window.



Index Commands

Pressing the Index button in the open image file dialog creates a thumbnail index window for all the 
images in the current directory. These thumbnails will be recreated every time you do this, they will not 
be stored on disk (so it will not eat up any disk space). Note! this feature is only available when running 
under Windows 95 or under NT 4.0.

Pressing the right mouse button over an index window brings up a menu with the following commands:

Spawn viewer... Opens the 'Open image file' dialog.
Properties Opens a dialog with index window and other program settings.

For help, press [?] and then click on the control you want help 
with.
Recreate Opens this help text.
Help Opens this help text.

There is also the following keyboard commands:

Esc Close window.
Home Scroll to the top.
PgUp Scroll up one thumbnail
End Scroll to the bottom
PgDn Scroll down one thumbnail



Slide Show Scripts

You can display simple slide shows using Image Eye. There is currently no integrated slide show editor 
so you will have to construct the slide show file by hand. 
A slide show file is a text formatted file with an .IES extension. It must start with the text "ImageEye 
SlideShow {" followed by a variable number of statements and terminated with an "}". A statement is a 
commands string followed by a variable number of argument strings terminated by a ";". A string is a 
sequence of characters terminated either by a white space or a ";". If you want to include spaces or ;'s in 
the string, enclose the whole string in "'s. To insert a " character in a string, use "". You can also use C++ 
style comments: /* ... */ for a multiline comment or // for a until-end-of-line comment. Here is an 
example named TEST.IES:

/* 
 * This is an example slide show file
 */

ImageEye SlideShow {

  // First display a welcome picture and play a sound!
  display welcome.jpg; 
  shell "Play" "c:\windows\media\chord.wav";
  delay key; // Wait for a keypress

  // Then display some product adds
  display prod1.bmp; delay 5;
  display "product 2.jpg"; delay 5;

  // Finally pop up a text file with further info
  shell open moreinfo.txt;

  // Toggle between two images until user press Esc
  loop {
    display "forever.png";
    display "and ever.png";
  }
}

These are the currently available commands:
delay num Pause num seconds before continuing the slide show.
delay key Wait for the user to press any key or left mouse button.
display str Display the image file str.
loop { ... }Loops the statements ... until Esc is pressed.
loop num { ... } Loop num times the statements ....
shell str Run the program file str.
shell verb str Execute the Windows shell command 'verb' on the document 'str'



File Formats

Image Eye can read and display the following image file formats:

File Extension: Description:

BMP, DIB, RLE, ICO, CUR Msft Windows/IBM OS/2 (Device Independent) BitMap / Icon / 
Cursor.
1,4,8,24 bits/pixel. Uncompressed or RLE.

IFF, LBM, BBM Electronic Arts Interchange File Format.
This is a more general data format; only 'ILMB' data are handled:
1..8,24 bits/pixel planar type 49h and 8 bits/pixel type 50h.
Compression types supported: No Compression (0), Byte Run/RLE (1).

FIF Iterated Systems Fractal Image File format.
24 bits/pixel. Fractal compression.
This format has the very special property of being resolution independent 
but Image Eye will always decompress these file to the same resolution 
as the image had before compression. Note! You need to install the free 
32bit decoder (Deco_32.dll) from Iterated systems in order to be able to 
view these files. This file can be downloaded separately from FMJ-
Software's www site.

GIF CompuServe Graphics Interchange Format v87a, v89a.
1..8 bits/pixel. LZW compression. Uninterlaced or interlaced.
Multiple image files, animations and overlay text not supported.

JPG Joint Photographic Experts Group, JPEG - JFIF.
Baseline JPEG support: sequential DCT based Huffman compression 
with 8 bits/component data precision. Can also read extended precision 
quantization tables (word size) and an extended number of Huffman 
tables (max. 4DC & 4AC).
YCbCr, RGB and Grayscale color spaces supported.

MAC MacPaint image.
1 bit/pixel. 576x720 res. RLE.

NEO Atari Neochrome image.
1..4 bits/pixel. Uncompressed.

PCX ZSoft image - PC Paintbrush.
1,4,8, 24 bits/pixel. Uncompressed or RLE.

PIC Pictor / PC Paint.
1, 4, 8 bits/pixel. RLE.

PNG Portable Network Graphics.
Inflate/Deflate compression. Uninterlaced or Adam7 interlaced.



Grayscale: 1,2,4,8,16 bits/pixel.
Palette: 1,2,4,8 bits/pixel.
RGB: 8,16 bits/pixel.
Any alpha channels, transparency colors, gamma corrections, an color 
correction table are ignored.

RAS, SUN Sun Raster format.
1, 8 or 24 bits/pixel. Uncompressed.
No support for text formatted data.

PBM, PGM, PPM PBMPLUS Portable BitMap, GrayMap, PixelMap.
1,8,24 bits/pixel.
Uncompressed or Ascii text format.

TGA Truevision TARGA image.
8, 15, 16, 24, 32 bits/pixel. Uncompressed or RLE.
No support for interlaced files.

TIF Tag Image File Format.
1, 2, 4, 8, 24 bit/pixel supported.
Uncompressed, Packbits, LZW and Predicted (type 2) LZW compression.
Color and grayscale response curves are ignored.

Image Eye can write to the following image file formats:

File Extension: Description:
BMP Msft Windows BitMap format.

8 or 24 bits/pixel.



RID FMJ-Software, Raw Image Data Descriptor Files. 
RGB, YCbCr, HSI and Grayscale color spaces, 8 bits/component only.
An ASCII text file containing a    description    of how an uncompressed 
(raw) image is stored in another file or files. This provides for a way to 
view images and data dumps,    like satellite imagery, which are very 
often stored uncompressed in simple, but nonstandard formats.





Revision History

future versions,

Things that I may (or perhaps, may not) implement in future versions:
- More input formats; send me a description of any format(s) you want me to include and I may add
it.
- A slide show editor and more slide show commands.

version 3.1, <97-01-20>

This is the first officially promoted release of Image Eye.

Removed the 'nag box' from the unregistered versions (it was a little too cruel...) - instead the text 
'unregistered' is painted in the upper left corner of images and the software will disable itself after 30 
days of use. The slide show feature is now also available in the unregistered version.

Added view->Next image file / view->Previous image file (also accessible through the PgUp / PgDn 
keys) to quickly view the (alphabetically) next / previous image in the current directory.

Added 'optional' support for .FIF files - Fractal Image Files. To enable it, you must have installed 
Iterated Systems free 32bit decoder library; Deco_32.dll version 6.0 or later. This file can downloaded 
from my www site.

Image files must now have the correct file extension to be recognized by the index feature. The 
previous version tried to determine if it was an image file even if it had an incorrect extension. 
However, some file types simply were not constructed in such a way that they can be 100% reliably 
detected which sometimes caused the index feature to load a non-image file as some image file type, 
which in turn could make it crash...

The first time the program is installed, it now asks if it should associate file types with itself. There's 
also a little checkbox that you can use to toggle all file associations on or off.

Added new slide show script command "delay key" to wait for a keypress.

Fixed a bug with missalignment of some 4bit .BMP files.

Fixed a bug that made it crash on a few .GIF files.

Fixed a serious bug in the printing code.

Added the option to measure the time it takes to load an image - for comparing performance with other
viewers...

Licensed the LZW algorithm used in GIF and TIFF files from Unisys.

version 3.0, <96-12-10>

First 32bit Windows release.



version 2.1, <94-01-01>

Last of the (by now long forgotten) DOS versions.





PVP:



The number of times you have opened an image file in the program.



The number of times you have saved an image from the program.



Windows version and build number.



CPU type and number. 



Display resolution and color depth.



The image files resolution and color depth.



The complete name of the image file.



Program version number.



PGP:



 FMJ-Software is a pseudonym for F. Markus Jönsson, who wrote this program.



If you are connected to the Internet and have a www browser installed, you can click here to visit FMJ-
Software’s www-site!



Check this box if you want Image Eye to register itself for the ‘open’ command in the Windows shell for 
the supported image file types. This will let you open an image file from the Windows Explorer simply by
double-clicking on it. 
Note! You will always be prompted before any association made by another program is overwritten.



Click to enter your registration keycode.



Click to uninstall the program and clean up the registry.



Licensee.



POP:



Normally, in 8bit (256 color) modes, Windows uses 20 fixed colors and 236 modifiable. Checking this 
box will set it to use only 2 fixed colors (black and white) which leaves 254 modifiable. It will make the 
images look better but all window controls and stuff will become black and white as long as an image 
window is open.



Check this box to use a fixed standard palette when displaying images in 8bit (256 color) modes. This 
will let you have multiple image windows open without them ‘stealing colors’ from each other. Image 
quality is still quite ok if you enable dithering as well.



When displaying an image in a video mode with lower color depth than the image has, enabling Floyd 
Steinberg dithering can drastically improve the subjective image quality. It tales a little extra time to 
compute but is definitely recommended.



When displaying a 24bit image in a 15 or 16bit video mode, enabling Floyd Steinberg dithering can 
improve the subjective image quality. The improvement may not be very noticeable though and it does 
take some extra time to compute...



Check to run the program with the image window maximized.
Check to display the image resolution in the window title bar.
Check to display the time it took to load the image in the window title bar.



Check to automatically size the image to the window when you resize a window.



Check to use a faster but less accurate DCT algorithm for JPEG decompression. The image quality 
degradation isn’t very noticeable but neither is the time saving...
Check to use a box filter for upsampling subsampled JPEG-color components instead of a more accurate 
triangular filter. The subjective image quality differs very little and most decoders just uses the faster box 
filter...



PIP:



Check to show directories in the file listing.



Check to show non-image files the file listing.



Check to display image resolutions and color depths



Check to display image file sizes.



Enter maximum horizontal size of image icons (in pixels).



Enter maximum vertical size of image icons (in pixels).



Enter spacing between image icons (in pixels).





Troubleshooting and Frequently Asked Questions

Q How do I register Image Eye, what does it cost and how do I pay for it?
A Look in the file REGISTER.TXT that comes with the program. It contains detailed instructions. You 

can pay by credit card, by cheque, by bank transfer, or by cash.

Q How do I uninstall Image Eye?
A Run the program and open an image file. Click with the right mouse button on the image and select 

'Properties' from the popup menu. Select the program tab and click on the 'Uninstall' button.

Q Why don't you do a French/Dutch/Japanese/whatever language version?
A Partly because I do not have the necessary language skills, but mostly because developing and 

maintaining several different language versions would mean a huge amount of additional work and I 
believe that 99.99% of the users knows enough of the English language to use the present version. If 
anyone would like to translate the help file, then I'd be happy to supply the necessary English source 
texts.

Q I select, say 25 files, and try to open them all simultaneously but I get all sorts of errors!
A Well, you are probably running Windows 95 (or 3.1, shudder...), right? Trying to open that many files

at once will eat up so many 'resources' (file handles, bitmap handles and stuff, this is not the same as 
free memory) that the OS runs out of 'resource space'. Try setting FILES=50 or something like that in
your CONFIG.SYS file and it will probably help! (See it's still running on top of old DOS!).
If it doesn't, well remember that a typical 24bit full screen image takes up about 3MB so 25 such 
images eats up 75MB! That's enough to make any OS feel just a little bit unhappy! (i.e. if you don't 
happen to have tons and tons of memory)

Q Is it possible to license Image Eye for use in / bundling with other products?
A Yes it is available for low-cost mass-licensing! Please contact me for price information!

Q When trying to run under Windows 3.1, it complains about not being able to load COMCTL32.DLL 
when I try to start it.

A You must have a Win32s version that supports the common controls introduced in Windows 
95.When this was written, this means Win32s v1.3. Look in the WIN32S.INI file in the ...\
WINDOWS\SYSTEM directory to determine what version of Win32s you have. If you need an 
update you can get it from Microsoft, or, you can download it from my WWW-page.

Q I see no 'Index' or 'View' buttons in the Open image file dialog!
A These are only available when running under Windows 95 or Windows NT 4.0.

The following selected Q&A's have been reproduced from the Shareware FAQ by kind permission of 
Mitchell Friedman, ASP Public Relations. The Shareware FAQ is copyright 1995-1997, Association of 
Shareware Professionals, All Rights Reserved.

Q What is shareware?
A Shareware is a marketing method, not a type of software. Unlike software marketed through normal 

retail channels, where you are forced to pay for the product before you've even seen it, the shareware
marketing method lets you try a program for a period of time before you buy it. Since you've tried a 



shareware program, you know whether it will meet your needs before you pay for it. Shareware 
programs are just like programs you find in major stores, catalogs, and other places where people 
purchase software -- except you get to use them, on your own computer, before paying for them.

Q What happens if I like a shareware program?
A You pay for it at the end of a trial period (typically 30 days) by sending the author a fee he or she has

established for the program.

Q Why should I pay for and register a shareware program?
A The same reason you should pay for any program: because it is the honest thing to do. Shareware is 

commercial software, fully protected by copyright laws. Like other business owners, shareware 
authors expect to earn money for making their programs available. Paying for and registering a 
program also entitles you to support from the author and other benefits, as specified by the author. 
Moreover, the more consumers who pay an author to use a program, the more likely the author will 
continue to improve it and to offer new programs.

Q How do shareware programs compare with other kinds of software?
A Consumers who purchase shareware programs receive a level of product support that exceeds what 

traditional software manufacturers deliver. Shareware users who need support often speak directly to 
the actual developer of the program, who is intimately familiar with how it operates and therefore 
can provide excellent technical support. Shareware authors often fix bugs in programs and add 
features quickly, based on feedback from users. There is a wide price range for shareware, as there is 
with software distributed through other channels. In general, many shareware programs cost less than
other kinds of software, while some programs cost about the same as retail counterparts. 

Q What do I receive when I pay for a shareware program, besides the use of the program?
A Typically, the same things you receive when you pay for other software: support by telephone, fax, 

computer bulletin board, and/or through online services such as America Online, CompuServe, and 
Microsoft Network. Many authors also send manuals, reference cards, and other printed materials, 
and may offer free upgrades. Every shareware program is different, so the version you purchase 
comes with different materials. Documentation files included with the program describe the benefits 
you receive by paying for and registering a particular shareware program. 

Q What happens if I don't like a shareware program?
A You simply stop using the program, and remove it from your system. Since you have had the 

opportunity to try the program first before paying for it, you lose only the tiny amount of money you 
spent to download the program or to acquire it from a vendor or other source.

Q I ordered a shareware program from a catalog and paid for the disk. Why should I pay more now?
A Shareware vendors distribute shareware versions of programs, charging a small fee for the costs of 

disk duplication and advertising, plus a small profit. Most shareware authors allow this type of 
distribution so you'll have a chance to try their programs. However, none of the money paid to a 
shareware vendor goes to the author. If you try a shareware program, then continue to use it after the 
trial period, you must pay for and register the program. The same principal applies if you buy a 
shareware disk at a computer show or find a shareware program on a CD-ROM disc or at a store.






